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2. Internet ja sähköposti 
FireFox-tuki: http://support.mozilla.org/fi/kb/Firefoxin%20k%C3%A4ytt%C3%A4minen  

2.1 Piilokopio 
Kun lähetät sähköpostia, voit piilokopio-kentässä lähettää sähköpostin jollekin salaa niin, etteivät muut 

vastaanottajat tiedä. Esimerkiksi vaikka itsellesi kopion. 

Outlookissa jos ei näy Bcc -> Options -> Show Bcc. 

2.2 Tiedostojen tarkistaminen virusten varalta 
Joissain sähköpostiohjelmissa voi erikseen tarkistaa saapuneista sähköpostiviesteistä niiden liitteet viruksien 
varalta. Usein tämän toiminnon saa esiin esim. hiiren oikealla napilla tai jostakin ylävalikosta, toiminto voi 

olla esim. Scan Attachment for Viruses.  

2.3 Kansioiden luominen ja nimeäminen  
Outlookissa voi luoda Cabinet-kansioon omia kansioita. Klikkaa Cabinet-kansion päällä hiiren oikeaa nappia ja 

valitse Create New Folder. Kirjoita kansiolle nimi. Kansion nimeä pääset muokkaamaan klikkaamalla kansion 
päällä hiiren oikealla napilla ja valitsemalla Rename. 

2.4 Viestien siirtäminen kansioihin  
Outlookissa viestit on helppo siirtää kansioihin raahaamalla. 

2.5 Viestien lajitteleminen  
Useissa sähköpostiohjelmissa voi viestejä lajitella esim. saapumisajan mukaan. Käyttöliittymässä näkyy 
tällöin Sort tai vastaava tai mahdollisesti jo suoraan esim. lähettäjän nimi –palkkia klikkaamalla viestit 

lajittuvat lähettäjän nimen mukaan aakkosiin. 

2.6 Osoitteisto (yksittäinen osoite, jakelulista tai ryhmä)  
Outlookissa saa esiin Metropolian osoitekirjan kirjan näköisestä kuvakkeesta (Address Book) kun on 

kirjoittamassa sähköpostiviestiä. Myös jos klikkaat To… tai Cc… -nappia niin pääset hakemaan vastaanottajia 
osoitekirjasta. 

Saat lisättyä henkilöitä omiin kontakteihisi osoitekirjasta, hae ensin haluamasi henkilö ja klikkaa hänen 

nimensä päällä hiiren oikeaa nappia -> Add to Contacts. Näin lisäämäsi henkilöt menevät Contacts-

kuvakkeen alle osoitekirjaasi.  

2.7 WWW-sivun löytäminen URL-osoitteen perusteella 
Maalaa URL, CTRL+C, mene selaimeen, klikkaa osoiteriville (tyhjennä osoiterivi jos vahingossa klikkasit sen 

keskelle niin, ettei osoite ole valittuna: CTRL+A, Delete), CTRL+V. 

 

2.8 Vihjeitä sähköpostin ja Internetin turvalliseen käyttämiseen 

 Noudata harkintaa, kun avaat sähköpostiviestien liitteitä. Sähköpostiviestien liitetiedostot ovat yleisin 
virustartuntojen lähde. Älä koskaan avaa liitettä, joka on peräisin tuntemattomalta henkilöltä. Jos 

tunnet lähettäjän, mutta jos et odottanut liitetiedostoa, varmista, että liite on peräisin lähettäjältä.  
 Suojaa henkilökohtaiset tiedot huolellisesti. Jos sivustossa kysytään luottokortin numeroa, 

pankkiyhteystietoja tai muita henkilökohtaisia tietoja, varmista sivuston ja 

tapahtumienkäsittelyjärjestelmän luotettavuus.  

 Noudata harkintaa, kun napsautat sähköpostiviestien hyperlinkkejä. Hyperlinkkejä, joista avautuu 

napsauttamalla sivustoja, käytetään tietojen kalasteluun ja vakoiluohjelmien huijauksiin. Lisäksi ne 
voivat välittää viruksia. Napsauta sähköpostiviesteissä vain linkkejä, joihin luotat.  

http://support.mozilla.org/fi/kb/Firefoxin%20k%C3%A4ytt%C3%A4minen
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 Asenna lisäosia vain sivustoista, joihin luotat. Selainten lisäosien avulla sivustot voivat tuoda 

esimerkiksi työkalurivejä, pörssitiedotteita, videoita ja animaatioita näkyviin. Lisäosat voivat kuitenkin 

asentaa myös vakoilu- ja haittaohjelmia. Jos sivustossa pyydetään asentamaan lisäosa, varmista 

ennen asentamista, että sivusto on luotettava. 

2.9 Evästeet 
 Eväste (Cookie) on dataa, jonka web-palvelin tallentaa käyttäjän tietokoneelle. Selain lähettää 

evästeet vain kyseiselle palvelimelle. 

 Evästeellä tarkoitetaan sellaista tietoa, jonka palvelun tarjoajan palvelin lähettää käyttäjän 

selainohjelmalle pyytäen selainta tallentamaan tiedon käyttäjän päätelaitteelle ja jota kyseinen 

palvelun tarjoajan palvelin voi myöhemmin pyytää takaisin. Kyse on käytännössä pienestä 
tietomäärästä, tyypillisesti lyhyestä tekstistä. 

 Evästeitä on kahta lajia, istuntokohtaisia session cookie ja pysyviä persistent cookie. 

o Istuntokohtaiset evästeet vanhenevat kun käyttäjä lopettaa istunnon web-palvelussa. 
o Pysyvät evästeet säilytetään tiettyyn aikarajaan asti tai kunnes käyttäjä ne tuhoaa. 

 Selaimet lähettävät evästeen vain sille palvelimelle, joka on sen alun perin käyttäjälle lähettänyt. 

 Salliminen tietyille sivuille: Selaimesta työkalut (tools) -> Asetukset (options) -> Privacy -> Accept 

cookies from sites -> Exceptions 

 Lähde: http://fi.wikipedia.org/wiki/Ev%C3%A4ste  

2.10 Selaimen asetukset  
 Aloitussivun määrittäminen  

o Selaimesta työkalut (tools) -> Asetukset (options) -> Aloitussivu (Homepage) 
 Ponnahdusikkunoiden estäminen tai salliminen 

o Selaimesta työkalut (tools) -> Asetukset (options) -> Content -> Block pop-up windows = 

estää kaikki. Jos haluat sallia joitain, niin klikkaa nappia Exceptions. 

o http://www.nettitieto.fi/showpage.php?id=60 
 Välimuistin ja sivuhistorian tyhjentäminen 

o Selaimesta työkalut (tools) -> Clear Recent History 

o Automaattisen tyhjennyksen määritteleminen: Selaimesta työkalut (tools) -> asetukset 
(options) -> Privacy -> valitse Clear history when Firefox closes. 

4.11 Netiketti 
 Netti + etiketti = netiketti. 

 Netin käytön epäviralliset sosiaalisuussäännöt. 

 Lähde: http://fi.wikipedia.org/wiki/Netiketti  

 

 Ole kohtelias sähköpostia kirjoittaessasi. 

o Älä kirjoita sähköpostissa mitään sellaista, mitä et olisi valmis sanomaan henkilölle 
kasvotusten. Ei ole suositeltavaa levittää ketjukirjeitä eteenpäin. Ei kannata myöskään 

lähettää vitsejä tai asiattomia viestejä henkilöille, joita ei tunne henkilökohtaisesti. 

 Kunnioita vastaanottajan sähköpostilaatikkoa. 

o Älä tarkoituksella kuormita vastaanottajan postilaatikkoa. Harkitse ennen liitetiedostojen 
lähettämistä, ovatko ne todella tarpeellisia ja onko vastaanottajalla oikea sovellus niiden 

avaamiseksi. Ota huomioon, että sähköpostilla tulevat pila- ja onnitteluohjelmat saattavat 
levittää tietokoneviruksia ja tukkia sähköpostijärjestelmiä, siksi niiden avaamisessa on 

noudatettava suurta varovaisuutta ja harkintaa. 
 Ole oma itsesi. 

o Kytkeydy nettiin aina omalla tunnuksellasi ja salasanallasi. Säilytä salasanaa huolellisesti, 

jotta muut eivät saa sitä selville. Jos poistut koneeltasi hetkeksi, käytä salasanasuojattua 

näytönsäästäjää, jotta kukaan ei pääse lähettämään sähköpostia tai käyttämään verkkoa 
nimissäsi. Käytä nimimerkkiä tai esiinny ilman nimeä vain palveluissa, joissa se on yleinen 

käytäntö. 
 Kirjoita harkiten keskusteluryhmiin. 

o Jos kirjoitat viestejä julkisiin keskusteluryhmiin varmista, että viestisi liittyy ryhmän 

aiheeseen. Älä lähetä samaa viestiä tarpeettoman moneen ryhmään. Ole kohtelias ja 

ystävällinen, äläkä tarkoituksella provosoi riitoja tai hauku muita keskustelijoita. 

http://fi.wikipedia.org/wiki/Ev%C3%A4ste
http://www.nettitieto.fi/showpage.php?id=60
http://fi.wikipedia.org/wiki/Netiketti
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 Noudata operaattorin antamia ohjeita. 

o Jos säilytät sähköpostiviestejä operaattorin palvelimella, poista tarpeettomiksi käyneet viestit 

ja noudata käyttäjäkohtaisia tilakiintiöitä. Noudata myös muita operaattorin ohjeita 

esimerkiksi välityspalvelimen (proxy) käytöstä. 
 Noudata huolellisuutta tiedostojen suhteen. 

o Noudata normaalia huolellisuutta ja varovaisuutta silloin, kun lähetät muille käyttäjille 

ohjelmatiedostoja tai dokumentteja tai kun lisäät niitä omalle www-sivullesi. Mikäli 
mahdollista, tarkista tiedostot virusten varalta ennen niiden lähettämistä. 

 Tiedä mihin sitoudut. 

o Verkossa on erilaisia palveluita, joiden käyttäjäksi pitää rekisteröityä. Lue ohjeet huolellisesti 
ja varmista, että ymmärrät ne, ennen kuin sitoudut mihinkään. Älä koskaan paina Kyllä/Yes -

painiketta tai vastaa myöntävästi, ellet varmuudella ymmärrä kysymystä. Noudata erityistä 

varovaisuutta käyttäessäsi vieraskielisiä palveluita. Jos palvelu vaatii rekisteröitymistä ja 
kysyy henkilötietojasi, harkitse mitä tietoja itsestäsi ilmoitat. 

 Muista lähdekritiikki. 

o Muista, että netissä ei ole julkaisukynnystä. Kaikki www-sivuilla oleva ei välttämättä pidä 
paikkaansa. Mikäli jokin tarjous tai palvelu kuulostaa liian hyvältä ollakseen totta, se ei 

välttämättä olekaan sitä. 

 Laki ja netti. 

o Vaikka useimmat lait on kirjoitettu ennen tietoverkkojen yleistymistä, netti ei tietenkään ole 
lakien ulkopuolella, vaan voimassa olevat lait koskevat nettiäkin. Kaikki sellainen, mikä olisi 

laitonta muutoinkin, on laitonta myös netissä. Lisäksi tietotekniikan nopea yleistyminen on 
pakottanut laatimaan aivan uusia lakeja, joissa huomioidaan verkon erityispiirteitä. 

Viestinnän ja netin vapauteen liittyy aina myös vastuu. Esimerkiksi www-sivun tekijä on aina 

itse vastuussa sivunsa sisällöstä. Verkossa olevat sivut näkyvät kaikille maailman 
nettikäyttäjille. Älä siis laita sivulle herjaavaa tai loukkaavaa aineistoa tai mitään muutakaan 

sellaista, jota et muussa yhteydessä olisi valmis esittämään. 
o Tekijänoikeus- ja tavaramerkkilaki. 

 Älä laita www-sivullesi aineistoa - esimerkiksi tuotenimiä, musiikkia, tekstiä, 
valokuvia, piirroksia tai mp3-tiedostoja - johon sinulla ei ole oikeuksia. Aineiston 

luvaton käyttö saattaa johtaa taloudellisiin korvausvaatimuksiin ja muihin 

oikeudellisiin seuraamuksiin. 
o Viestintäsalaisuus. 

 Kansalaisella on perustuslaissa määritelty oikeus luottamukselliseen viestintään. Laki 
koskee myös sähköpostia ja kaikkea sähköistä viestiliikennettä. Älä siis avaa toiselle 

vastaanottajalle osoitettuja sähköpostiviestejä ilman tämän suostumusta. 

o Älä häiritse tietoverkon toimintaa. 
 Tietoverkon, tiedonsiirron tai sähköpostin toiminnan tarkoituksellinen häirintä tai 

ylikuormitus on kiellettyä. 
o Hakkerointi. 

 Vieraaseen tietojärjestelmään tunkeutuminen tai järjestelmän luvaton käyttö - jopa 
pelkkä sen yrityskin - on rikos, josta voi seurata vankeutta. Myös toisen käyttäjän 

tunnusten ja salasanojen arvailu ja kokeileminen on kiellettyä. 

o Virusten kirjoittaminen ja levitys. 
 Haitallisten virusten kirjoittaminen ja niiden tarkoituksellinen levittäminen on 

kiellettyä. 
o Älä lähetä sähköpostimainontaa. 

 Älä käytä sähköpostia markkinointiin, ellei sinulla ole lupaa vastaanottajilta, sillä laki 

kieltää koneellisen massalähetyksen yksityishenkilöille yhtä lailla faksilla, kännykkään 
tekstiviesteinä kuin sähköpostillakin. Tiedottaminen yrityksille, omille asiakkaille tai 

ystäville on kuitenkin sallittua. Poista näissäkin tapauksissa vastaanottajan nimi 
jakelulistalta, jos hän sitä pyytää. 

o Henkilörekisterin pito. 

 Jos keräät henkilötietoja verkossa tai sivullasi vierailevilta kävijöiltä (esimerkiksi 
edellyttämällä heiltä rekisteröitymistä), noudata henkilötietolain määräyksiä. 

o Lapsiporno. 
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 Lapsipornon levittäminen ja hallussapito on kielletty riippumatta siitä, missä 

muodossa aineisto on. 

o Rasismi. 
 Rasismi ja siihen yllyttäminen on kiellettyä. 

 Lähde: http://www.internetopas.com/netiketti/  

2.12 Kopioiminen ja/tai tallentaminen 
 URL-osoitteen kopioiminen 

o Klikkaa osoite rivillä kerran, osoite maalautuu. Jos vahingossa klikkaat kaksi kertaa, niin 

maalaa osoite. CTRL + C. 
 tekstin kopioiminen ja/tai tallentaminen tiedostoksi www-sivuilta 

o Maalaa teksti, CTRL+C, avaa tekstieditori, CTRL+V. 

 kuvan kopioiminen ja/tai tallentaminen www-sivuilta 

o Klikkaa kuvan päällä hiiren oikeaa nappia -> Save Image as. Etsi kansio, johon haluat kuvan 
tallentaa, nimeä kuva ja klikkaa Save. Jotkut kuvat on suojattu, ne saa talteen käyttämällä 

printscreen-toimintoa. 

2.13 Tekijänoikeudet 
 Lähteiden käyttö  

o Printin siirtäminen digitaaliseen muotoon on kappaleen valmistamista -> tarvitaan lupa 
teoksen tekijältä.  

o Verkkoaineiston linkittäminen esim. oppimateriaaliin siten, että aineisto avautuu uudelle 

sivulle ei ole kappaleen valmistamista -> näin saa tehdä ilman että kysyy teoksen tekijältä 
lupaa. Kohteliasta toki on ilmoittaa tekijälle. 

o Opetus on julkista esittämistä (oli tila mikä tahansa), aina tarvitaan lupa toisen materiaalin 
esittämiseen. 

 Verkossa olevia julkisesti (vapaasti) näkyviä teoksia saa esittää opetuksessa. (huom. 

Julkisesti verkossa oleva teos voi kuitenkin olla laiton, muista loppukäyttäjän 
vastuu). 

 Opiskelu ja tutkimus yksityistä toimintaa -> esim. koko teoksen kopiointi 
opiskelutarkoitukseen, omaan käyttöön, on sallittua 

o Jos et ole teoksen tekijä, tarvitset luvan näihin: 
 Yleisölle välittäminen (esim. oppimisympäristö verkossa). 

 Julkinen esittäminen (konsertti auditoriossa, elokuvan esitys luokkatilassa). 

 Kappaleiden levittäminen yleisön keskuuteen (vrt. oppimateriaalien jakaminen 
opiskelijoille). 

 Julkinen näyttäminen. 
 Lisätietoja 

o http://operight.fi 

o http://kopiraitti.fi 

o http://opettajantekijanoikeus.fi 
o http://copyright.aalto.fi/fi/ 

o FinElib-aineistot (e-aineistot): http://wiki.helsinki.fi/display/FinElib/FinElib-aineistot  
 Sari Soinisen tekemästä Tekijänoikeudet-PowerPoint-esityksestä. 

 

 Plagiointi 

o Toisen henkilön ideoiden, tietojen, kielen tai kirjoituksen käyttöä silloin kun se tehdään ilman 
alkuperäisen lähteen asianmukaista ilmoittamista. Se saattaa myös sisältää epärehellisyyden 

elementin, mikäli plagioija yrittää julkaista plagioidun työn alkuperäisenä. Plagiointi ei 

välttämättä ole sama asia kuin tekijänoikeusrikkomus, joka tapahtuu kun rikotaan 
tekijänoikeuslakia. Plagiointi koskee tekstin, kirjoituksen tms. sisältöä kun taas tekijänoikeus 

koskee niiden muotoa. 
 Lähde: http://fi.wikipedia.org/wiki/Plagiointi  

 

2.14 Tiedonhaku  
 Hakukanavat (hakukoneet, tietokannat, sanastot)  

http://www.internetopas.com/netiketti/
http://operight.fi/
http://kopiraitti.fi/
http://opettajantekijanoikeus.fi/
http://copyright.aalto.fi/fi/
http://wiki.helsinki.fi/display/FinElib/FinElib-aineistot
http://fi.wikipedia.org/wiki/Plagiointi
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o Näppärä hakukonesivu: http://www.saunalahti.fi/~seho/hakukoneet.html  

o Hakuvinkkejä (Googlelle, pitäisi toimia myös Bingissä ja Yahoossa): 

 Kun haluat hakea juuri jotain tiettyä lausetta, laita hakusi kohde lainausmerkkeihin. 
”Linux distributions” 

 Kun haluat, ettei hakutuloksissa ole jotain tiettyä sanaa, laita sen eteen 
miinusmerkki. Linux distributions –ubuntu 

 Kun haluat hakea jotain tiettyä asiaa joltain tietyltä sivustolta voit suorittaa 

sivustohaun laittamalla sanan site haun ensimmäiseksi, sitten kaksoispisteellä 
erotettuna sivuston osoite ja lopuksi hakusana(t). site:howtogeek.com windows 7 

 Samalla periaatteella voit hakea myös domaineista. site:.edu 
 Kun haluat hakea jotain sanaa ja siihen liittyviä sanoja, laita haun eteen tilde (~). 

~geek 
 Asteriski on ikään kuin villikortti, sen avulla voi hakea lauseita johon haetaan 

asteriskin sijaan mikä tahansa sana. Esimerkin lauseella voi selvittää, mitkä kaikki 

yhtiöt Google on ostanut ja kuinka monta dollaria se on kustakin maksanut: “google 
purchased * for * dollars”  

 Tietyllä aikajaksolla tapahtuneita hakusanaasi liittyviä asioita voi hakea laittamalla 
aikamääritteiden väliin kaksi pistettä. ubuntu 2008..2010 

 Kun kirjoitat hakusanasi eteen filetype: voit hakea vain tiettyjä tiedostoja jotka 

liittyvät hakusanaasi. filetype:pdf how to geek 
 Voit hakea myös niin, että vain toinen hakusanoistasi on mukana, ei kummatkin 

samassa hakutuloksessa, kirjoittamalla sanojen väliin OR. ubuntu OR linux 
 Laita hakusanan eteen define: kun haluat etsiä jolle sanalle määritelmää. 

define:word 
 Googlea voi käyttää myös laskimena, laskutoimituksina toimivat + - * /. (4 + 2) * (6 

/ 3) 
 Googlella voi myös muuntaa yksiköitä kirjaamalla yksikön määrän, sitten yksikön 

nimen, sitten sanan in ja lopuksi sen yksikön, joksi yksikkö halutaan muuntaa. 5 
nautical miles in kilometers 

 Rahayksiköiden muuntaminen onnistuu myös, kirjaa ensin määrä ja ilman välilyöntiä 

perään yksikön lyhenne (http://www.currencysystem.com/codes/), sitten sana in ja 

lopuksi sen yksikön lyhenne, joksi rahayksikkö halutaan muuntaa. 1200USD in GBP 
 Laita sanan eteen etymology: kun haluat selvittää sanan alkuperän. etymology: 

geek 
 Tarjolla olevat lennot kaupungista toiseen saa, kun laittaa kaupunkien nimien väliin 

to. Colombo To Bangkok 
 Lähde: http://www.howtogeek.com/106718/how-to-search-google-like-a-pro-11-

tricks-you-have-to-know/ 
o Google: http://fi.wikipedia.org/wiki/Google 

 Pitkälle kehittynyt hakukone, jossa yllämainittujen näppärien hakujen lisäksi voi 

hakea mm. pelkkiä kuvia. 
 Ohjeita: 

http://support.google.com/websearch/bin/answer.py?hl=en&answer=134479&topic

=1221265&ctx=topic  
 How to Use Google Search More Effectively: 

http://mashable.com/2011/11/24/google-search-infographic/ 
o Bing: http://fi.wikipedia.org/wiki/Bing  

o Yahoo: http://fi.wikipedia.org/wiki/Yahoo  

o Ask Jeeves: http://fi.wikipedia.org/wiki/Ask.com  
o Altavista: http://fi.wikipedia.org/wiki/Altavista  

o Muita vähemmän tunnettuja: Duckduckgo, Wolfram, Yebol, Teoma. 
o Google Scholar = maksuton hakupalvelu, jonka avulla voi etsiä tieteellisiä julkaisuja. 

http://fi.wikipedia.org/wiki/Google_Scholar  
 Hakutulosten arvioiminen 

o Relevanssi, lähde (onko luotettava), ikä.  

2.15 Verkkopalveluiden käyttö 

http://www.saunalahti.fi/~seho/hakukoneet.html
http://www.currencysystem.com/codes/
http://www.howtogeek.com/106718/how-to-search-google-like-a-pro-11-tricks-you-have-to-know/
http://www.howtogeek.com/106718/how-to-search-google-like-a-pro-11-tricks-you-have-to-know/
http://fi.wikipedia.org/wiki/Google
http://support.google.com/websearch/bin/answer.py?hl=en&answer=134479&topic=1221265&ctx=topic
http://support.google.com/websearch/bin/answer.py?hl=en&answer=134479&topic=1221265&ctx=topic
http://mashable.com/2011/11/24/google-search-infographic/
http://fi.wikipedia.org/wiki/Bing
http://fi.wikipedia.org/wiki/Yahoo
http://fi.wikipedia.org/wiki/Ask.com
http://fi.wikipedia.org/wiki/Altavista
http://fi.wikipedia.org/wiki/Google_Scholar
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 Rekisteröityminen palveluiden käyttäjäksi 

o Riippuu kovin paljon palvelusta johon on rekisteröitymässä, mutta yleisesti ottaen joutuu 

antamaan henkilötietojaan ja osoitetietojaan. 

o Tarkista aina mihin henkilökohtaisia tietojasi käytetään ja annetaanko tiedot suojatun 
yhteyden kautta.  

o Usein tietojen lähettämisen jälkeen sähköpostiin tulee varmistusviesti, jossa on mahdollisesti 
myös linkki jolla tili/palvelu pitää aktivoida. 

o Käyttäjän tunnistaminen on myös hyvä asia, sillä se parantaa palvelun luotettavuutta. 

o Käyttäjätunnus ja salasana antavat jonkin verran suojaa, mutta esim. verkkopankeissa on 
oltava myös vaihtuvia varmennuskeinoja kuten erilaiset tunnusluvut. 

 Rekisteriseloste 

o Kannattaa aina tarkistaa, jotta saa selville onko yritys todellinen. 
o Suomalaisten yritysten sivuilla pitää olla rekisteriseloste, jos niillä kysytään henkilökohtaisia 

tietoja. 
 Suojattujen sivujen käyttö 

o Suojaus tarkoittaa että yhteyden aikainen liikenne on salattu.  

 Tieto muutetaan salakieliseksi ja puretaan alkuperäiseen asuunsa vasta 

vastaanottajalla. 
o Suojatun sivuston tunnistaa siitä, että sivuston merkkinä selainikkunan alareunassa olevalla 

tilarivillä on kiinni olevan lukon kuva ja selaimen osoiterivillä on http:n asemasta https. 
 S-kirjain viittaa sanaan secure. 

 Tällöin sivusto on suojattu SSL-suojauksella (Secure Sockets Layer). 

 Varmenne 

o Suojatun sivuston käyttöön liittyy myös digitaalisen sertifikaatin eli varmenteen käyttö.  
 Sertifikaatilla selain pystyy tunnistamaan SSL-suojauksella suojatun sivuston. 

 Sertifikaatin voi tarkastaa klikkaamalla kaksi kertaa selaimen oikeassa alakulmassa 
tai osoiterivin reunassa olevaa lukkokuvaketta ja tutkimalla Myönnetty-kenttää. 

 Sertifikaatin pitäisi vastata avaamasi sivuston osoitteen kanssa.  
 Jos nimet eivät vastaa toisiaan voi kyseessä olla huijaus.  

 Jos et ole varma sertifikaatin asianmukaisuudesta, kannattaa sulkea sivusto 

henkilötietoja antamatta. 
 Tunnistautuminen 

o Monissa internetin palveluissa tunnistaudutaan eli todistetaan sähköisesti oma henkilöllisyys.  

o Tutuin tunnistautumisen muoto on verkkopankkitunnukset.  
o Operaattorit tarjoavat nykyään myös mobiilivarmennetta, joka on matkapuhelimessa 

mukana kulkeva sähköinen henkilöllisyystodistus. 

 Tämän toivotaan entisestään helpottavan turvallista sähköistä asiointia. 
 Lähde: http://www.tietoturvaopas.fi/internetinpalvelut/palveluidenturvallinenkaytto.html  

2.16 Sosiaalisen median käyttö  
 Palveluiden tunnistaminen  

o Sosiaalisen median palveluissa on tyypillisesti paljon sosiaalisia toimintoja kuten 

 Ystäviä/kavereita. 

 Rinkejä joihin lisätä henkilöitä. 
 Verkostoja. 

 Mahdollisuus julkaista omia juttujaan (statuksia, tarinoita, mielipiteitä, kuvia, 
videoita..) 

 Mahdollisuus kommentoida omia ja toisten julkaisuja. 

 Mahdollisuus keskusteluun (foorumit, pikaviestit). 
 Mahdollisuus tykätä omista ja toisten julkaisuista. 

o Keskiössä on sisällön tuottaminen vuorovaikutteisesti.  
 Tämän toteuttamiseen käytetään hyödyksi tietoverkkoja ja tietotekniikkaa. 

 Käyttäjien välisiä suhteita ylläpidetään sosiaalisen median avulla. 
 Sosiaalisessa mediassa on aina kyse yhteisöistä. 

 Rekisteröityminen palveluiden käyttäjäksi  

o Vaatii usein rekisteröitymisen jo käyttäjien turvallisuuden takia.  

 Katso yllä kohta 2.15 

http://www.tietoturvaopas.fi/internetinpalvelut/palveluidenturvallinenkaytto.html
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 Tietoturva ja tietosuoja 

o Tietoturva = tietojen, palvelujen, järjestelmien ja tietoliikenteen suojaaminen. 

 Ulkoiset tietoturvauhat. 

 Ohjelmointivirheet. 
 Kolmijalkana luottamuksellisuus, eheys ja käytettävyys. 

o Tietosuoja = mitä tietoja käyttäjä jakaa itsestään ja kenelle. 
 Palvelun on laadittava rekisteriseloste kaikista henkilörekistereistä, siitä käyttäjä 

näkee kuka tietoja käsittelee ja mihin tarkoitukseen. Tästä tulee näkyä myös tieto 

miten henkilötietoja suojataan. 
 Tärkeinä piirteinä luottamuksellisuus, eheys, käytettävyys, pääsynvalvonta ja 

kiistämättömyys. 
o Kannattaa olla tarkkana vaikka identiteettivarkaudet ovatkin harvinaisia. 

 Itsestään ei kannata kertoa liikaa eikä jakaa julkisesti liian henkilökohtaisia tietoja tai 
kuvia kuten ei Internetissä muutenkaan. 

 Jos aiot julkaista jotain, mieti että se voi olla joskus kaikkien nähtävillä. 

 Internetiin kerran laitettu kuva on siellä ikuisesti, se löytyy aina jostain backup-
palvelimelta tms. vaikka poistaisit sen itse omasta profiilistasi tai kotisivultasi. 

 On syytä myös pitää oma tietokone virustorjunnallisesti ajan tasalla. 
 Tarkista yksityisasetukset ennen minkäänlaisten tietojen lisäämistä.  

 Muista kunnioittaa myös toisten käyttäjien yksityisyyttä.  

 Katso myös yllä kohdat 2., 2.8 ja 2.15 
 Yksityisyys, tietoturva ja tietosuoja verkossa: 

http://opettajatv.yle.fi/kurssit/Sosiaalinen_media_oppimisen_ja_opetuksen_valineen
a_osio3_tietoturva_tehtavat  

 Tietoturva ja tietosuoja sosiaalisessa mediassa: http://urn.fi/URN:NBN:fi:amk-
201105025566 

2.17 Tulostaminen 
 Sivun ja valinnan tulostaminen  

o File -> Print -> Tulostaa sivun. 

o Valitse alue -> File -> Print -> valitse Selection -> tulosta. 

 tulostusasetukset ja esikatselu 

o File -> Print Preview -> Saat esille esikatselun. 
 Page Setupista voit muokata esim. suuntaa (vaaka vai pysty) ja skaalausta 

(prosentteina tai valitsemalla Shrink to fit Page Width jolloin mahdutetaan sivulle 
leveyssuunnassa). 

 Skaalauksen ja suunnan saat muutettua myös suoraan esikatseluikkunan 
ylävalikosta. 

2.18 Suosikit / kirjanmerkit 
 Kun haluat lisätä sivun kirjanmerkkeihin, klikkaa ylävalikosta Bookmark This Page. 

o Name-kohdassa voit antaa kirjanmerkille nimen (oletusnimet ovat usein aika pitkiä). 

o Folder-kohdassa voit määritellä tuleeko kirjanmerkki kirjanmerkkikansioon vai selaimen 

kirjanmerkkipalkkiin.  
o Tags-kohdassa voit antaa tunnisteita kirjanmerkille. 

 Kirjanmerkeistä eniten käytetyt kannattaa ryhmitellä kirjanmerkkipalkkiin. 

 Loput kirjanmerkkikansioon, jonka saat siis esille kun klikkaat selaimen ylävalikosta Bookmarks. 

o Voit lisätä kirjanmerkkikansioon alakansioita esim. klikkaamalla hiiren oikeaa nappia -> New 
Folder. 

o Alakansioita kannattaa tehdä, se helpottaa kirjanmerkkien löytämistä. 
 Kirjanmerkkien muokkaaminen: Bookmarks -> Organize Bookmarks. 

o Valitse vasemmalta mitä kansioistasi haluat muokata tai kirjanmerkkipalkkia (Bookmarks 

Toolbar). 

o Klikkaamalla kansion nimeä voit muuttaa sen nimeä ja kuvausta. 
o Klikkaamalla kirjanmerkin nimeä voit muuttaa sen nimeä, kohdetta (www-osoitetta) ja 

tageja. 
o Voit raahata kansioita ja kirjanmerkkejä toisiin kansioihin raahaamalla.  

http://opettajatv.yle.fi/kurssit/Sosiaalinen_media_oppimisen_ja_opetuksen_valineena_osio3_tietoturva_tehtavat
http://opettajatv.yle.fi/kurssit/Sosiaalinen_media_oppimisen_ja_opetuksen_valineena_osio3_tietoturva_tehtavat
http://urn.fi/URN:NBN:fi:amk-201105025566
http://urn.fi/URN:NBN:fi:amk-201105025566
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o Organize-ylävalikosta voit mm. lisätä erottimia (New Separator). 

 Lisää erottimen siihen kohtaan missä sinulla on viimeisin valinta. 

 Kirjanmerkkipalkin (Bookmarks Toolbar) erottimia voi raahata selainikkunassa 
haluamaansa kohtaan. 

 Erottimilla saa siis jaoteltua kirjanmerkkejä eri ryhmiin. 

2.19 Etsi-toiminto 
 Katso kohta 2.14 

 Selaimissa on nykyään yleensä Googlen hakupalkki valmiina (usein oikeassa yläkulmassa). 

 Firefoxin erikoisuuksia: 

o Maalaa sana/sanoja -> Klikkaa hiiren oikeaa nappia -> Valitse Search Google for… -> 

Avautuu uusi välilehti -> Etsi. 
o Kun haluat etsiä sanoja sivulta, joka on parhaillaan auki: etsi uudestaan painamalla F3 tai 

valitsemalla Muokkaa (Edit) -> Etsi seuraava (Find Again) 

2.20 Ohje-toiminto 
 Help-nappi Firefox-selaimessa vie sivulle http://support.mozilla.org/en-US/home?as=u  

o Käyttö on yksinkertaista: syötä hakukenttään hakusana sen mukaan mihin tarvitset apua. 

 

http://support.mozilla.org/en-US/home?as=u

